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Warning 

Permanent damage may be done to the thermometer if the power supply connections are not done correctly. 
In particular, do not connect the power input (18-24VDC) to any of the analog output connectors. Note that 
the 20 mA analog output options are self-powered interfaces (by opposition to loop-powered interfaces), and 
thus do not require any external supply. 
 
With 0-10 volt analog outputs, avoid shorting output leads together; as this may destroy the electronic drivers 
inside the OFX modules. 
 
The supplied 24VDC power supply module is limited to 4A. Neoptix recommends that one power module be 
used for each OmniFlex chassis, despite the fact that more than one chassis can be linked together using 
only one power module. If more than one chassis is using a single power-supply module, care must be 
exercise to avoid overloading power-supply modules. 
 
Fiber optic probes are fragile, and will break if the bending radius becomes less than ~1cm, even temporarily. 
Probe breakages are not covered under the standard Neoptix warranty. 
 
To assure cleanliness of optical connectors, keep caps on unused connectors at all time. This is also 
required during operation, as parasitic light entering via unused connectors into the OFX modules may cause 
false temperature readings, even on other channels. 
 
 
The Neoptix OmniFlex products are CE marking certified. 
 
This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) 
this device may not cause harmful interference, and (2) this device must accept any interference received, 
including interference that may cause undesired operation. 
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1 END USER LICENSE & SOFTWARE WARRANTY AGREEMENT 
PLEASE READ THIS SOFTWARE LICENSE CAREFULLY BEFORE DOWNLOADING, INSTALLING OR 
USING ANY QUALITROL OR QUALITROL-SUPPLIED SOFTWARE.  BY DOWNLOADING OR 
INSTALLING THE SOFTWARE, OR USING THE EQUIPMENT THAT CONTAINS THIS SOFTWARE, YOU 
ARE CONSENTING TO BE BOUND BY THIS LICENSE.  
 
The following terms govern your use of the Software except to the extent a particular program (a) is the 
subject of a separate written agreement with Qualitrol or (b) includes a separate “clickwrap” license 
agreement as part of the installation and/or download process. To the extent of a conflict between the 
provisions of the foregoing documents, the order of precedence shall be (1) the written agreement, (2) the 
clickwrap agreement, and (3) this Software License. 
 
License.  Subject to the terms and conditions of and except as otherwise provided in this Agreement, 
Qualitrol Systems, Inc. or the Qualitrol Systems, Inc. subsidiary licensing the Software, if sale is not directly 
by Qualitrol Systems, Inc. (“Qualitrol”), and its suppliers grant to Customer (“Customer”) a nonexclusive and 
non-transferable license to use the specific Qualitrol program modules, feature set(s) or feature(s) for which 
Customer has paid the required license fees (the “Software”), in object code form only. In addition, the 
foregoing license shall also be subject to the following limitations, as applicable: 
 

• Unless otherwise expressly provided in the documentation, Customer shall use the Software 
solely as embedded in, for execution on, or (where the applicable documentation permits 
installation on non-Qualitrol equipment) for communication with Qualitrol equipment owned or 
leased by Customer 

 
• Customer’s use of the Software shall be limited  to use on a single hardware chassis, on a single 

central processing unit, as applicable, or use on such greater number of chasses or central 
processing units as Customer may have paid Qualitrol the required license fee; and 

 
• Customer’s use of the Software shall also be limited, as applicable and set forth in Customer’s 

purchase order or in Qualitrol’s product catalog, user documentation, or web site, to a maximum 
number of (a) seats (i.e. users with access to the installed Software), (b) concurrent users, 
sessions, ports, and/or issued and outstanding IP addresses, and/or (c) central processing unit 
cycles or instructions per second. Customer’s use of the Software shall also be limited by any 
other restrictions set forth in Customer’s purchase order or in Qualitrol’s product catalog, user 
documentation or web site for the Software. 

 
NOTE:  For evaluation or beta copies for which Qualitrol does not charge a license fee, the above 
requirement to pay a license fee does not apply. 
 
General Limitations.   Except as otherwise expressly provided under this Agreement, Customer shall have no 
right and Customer specifically agrees not to: 
 

(i) transfer, assign or sublicense its license rights to any other person, or use the Software on 
unauthorized or second-hand Qualitrol equipment, and any such attempted transfer, assignment 
or sublicense shall be void;   

 
(ii) make error corrections to or otherwise modify or adapt the Software or create derivative works 

based upon the Software, or to permit third parties to do the same; or (iii) decompile, decrypt, 
reverse engineer, disassemble or otherwise reduce the Software to human readable form to 
gain access to trade secrets or confidential information in the Software.   To the extent required 
by law, at Customer's request, Qualitrol shall provide Customer with the interface information 
needed to achieve interoperability between the Software and another independently created 
program, on payment of Qualitrol’s applicable fee.  Customer shall observe strict obligations of 
confidentiality with respect to such information.  
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Upgrades and Additional Copies. For purposes of this Agreement, “Software” shall include (and the terms 
and conditions of this Agreement shall apply to) any upgrades, updates, bug fixes or modified versions 
(collectively, “Upgrades”) or backup copies of the Software licensed or provided to Customer by Qualitrol or 
an authorized distributor for which  Customer has paid the applicable license fees. 
 
NOTWITHSTANDING ANY OTHER PROVISION OF THIS AGREEMENT:  (1) CUSTOMER HAS NO 
LICENSE OR RIGHT TO USE ANY SUCH ADDITIONAL COPIES OR UPGRADES UNLESS CUSTOMER, 
AT THE TIME OF ACQUIRING SUCH COPY OR UPGRADE, ALREADY HOLDS A VALID LICENSE TO 
THE ORIGINAL SOFTWARE  AND HAS PAID THE APPLICABLE FEE FOR THE UPGRADE; (2) USE OF 
UPGRADES IS LIMITED TO QUALITROL EQUIPMENT FOR WHICH CUSTOMER IS  THE ORIGINAL 
END USER PURCHASER OR  LESSEE OR WHO OTHERWISE HOLDS A VALID LICENSE TO USE THE 
SOFTWARE WHICH IS BEING UPGRADED; AND (3) USE OF ADDITIONAL COPIES IS LIMITED TO 
BACKUP PURPOSES ONLY. 
 
Proprietary Notices.   Customer agrees to maintain and reproduce all copyright and other proprietary notices 
on all copies, in any form, of the Software in the same form and manner that such copyright and other 
proprietary notices are included on the Software.  Except as expressly authorized in this Agreement, 
Customer shall not make any copies or duplicates or any Software without the prior written permission of 
Qualitrol.  Customer may make such backup copies of the Software as may be necessary for Customer’s 
lawful use, provided Customer affixes to such copies all copyright, confidentiality, and proprietary notices that 
appear on the original. 
 
Protection of Information.   Customer agrees that aspects of the Software and associated documentation, 
including the specific design and structure of individual programs, constitute trade secrets and/or copyrighted 
material of Qualitrol.  Customer shall not disclose, provide, or otherwise make available such trade secrets or 
copyrighted material in any form to any third party without the prior written consent of Qualitrol. Customer 
shall implement reasonable security measures to protect such trade secrets and copyrighted material.  Title 
to Software and documentation shall remain solely with Qualitrol. 
 
Term and Termination.  This License is effective until terminated. Customer may terminate this License at 
any time by destroying all copies of Software including any documentation.  Customer’s rights under this 
License will terminate immediately without notice from Qualitrol if Customer fails to comply with any provision 
of this License.  Upon termination, Customer must destroy all copies of Software in its possession or control. 
 
Customer Records.   Customer grants to Qualitrol and its independent accountants the right to examine 
Customer’s books, records and accounts during Customer’s normal business hours to verify compliance with 
this Agreement.  In the event such audit discloses non-compliance with this Agreement, Customer shall 
promptly pay to Qualitrol the appropriate licensee fees. 
 
Export.  Software, including technical data, may be subject to U.S. export control laws, including the U.S. 
Export Administration Act and its associated regulations, and may be subject to export or import regulations 
in other countries. Customer agrees to comply strictly with all such regulations and acknowledges that it has 
the responsibility to obtain licenses to export, re-export, or import Software. 
 
U.S. Government End Users.  The Software and associated software documentation qualify as “commercial 
items,” as that term is defined at 48 C.F.R. 2.101, consisting of “commercial computer software” and 
“commercial computer software documentation” as such terms are used in 48 C.F.R. 12.212.  Consistent 
with 48 C.F.R.12.212 and 48 C.F.R. 227.7202-1 through 227.7202-4, Licensee will provide to Government 
end user, or, if this Agreement is direct Government end user will acquire, the Software and software 
documentation with only those rights set forth herein that apply to nongovernmental customers. Use of this 
Software and software documentation constitutes agreement by the government entity that the computer 
software and computer software documentation is commercial, and constitutes acceptance of the rights and 
restrictions herein. 
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Limited Warranty. Qualitrol Systems, Inc. or the Qualitrol Systems, Inc. subsidiary licensing the Software, if 
sale is not directly by Qualitrol Systems, Inc. (“Qualitrol”) warrants that commencing from the date of delivery 
to Customer and continuing for a period of the longer of (a) ninety (90) days or (b) the period set forth in the 
Warranty Card accompanying  the Product (if any): (a) the media on which the Software is furnished will be 
free of defects in materials and workmanship under normal use; and (b) the Software substantially conforms 
to its published specifications.  The date of shipment of a Product by Qualitrol is set forth on the packaging 
material in which the Product is shipped.   Except for the foregoing, the Software is provided “AS IS”. This 
limited warranty extends only to the Customer who is the original licensee. Customer's sole and exclusive 
remedy and the entire liability of Qualitrol and its suppliers under this limited warranty will be, at Qualitrol or its 
service center's option, repair, replacement, or refund of the Software if reported (or, upon request, returned) 
to the party supplying the Software to Customer, if different than Qualitrol. In no event does Qualitrol warrant 
that the Software is error free or that Customer will be able to operate the Software without problems or 
interruptions.   In addition, due to the continual development of new techniques for intruding upon and 
attacking networks, Qualitrol does not warrant that the Software or any equipment, system or network on 
which the Software is used will be free of vulnerability to intrusion or attack. 
 
Restrictions. This warranty does not apply if the Product (a) has been altered, except by Qualitrol, (b) has not 
been installed, operated, repaired, or maintained in accordance with instructions supplied by Qualitrol, (c) has 
been subjected to abnormal physical or electrical stress, misuse, negligence, or accident; or (d) is licensed, 
for beta, evaluation, testing or demonstration purposes for which Qualitrol does not receive a payment of 
purchase price or license fee. 
 
DISCLAIMER OF WARRANTY.  EXCEPT AS SPECIFIED IN THIS WARRANTY, ALL EXPRESS OR 
IMPLIED CONDITIONS, REPRESENTATIONS, AND WARRANTIES INCLUDING, WITHOUT LIMITATION, 
ANY IMPLIED WARRANTY OR CONDITION OF MERCHANTABILITY, FITNESS FOR A PARTICULAR 
PURPOSE, NONINFRINGEMENT, SATISFACTORY QUALITY OR ARISING FROM A COURSE OF 
DEALING, LAW, USAGE, OR TRADE PRACTICE, ARE HEREBY EXCLUDED TO THE EXTENT 
ALLOWED BY APPLICABLE LAW.  TO THE EXTENT AN IMPLIED WARRANTY CANNOT BE 
EXCLUDED, SUCH WARRANTY IS LIMITED IN DURATION TO THE WARRANTY PERIOD.  BECAUSE 
SOME STATES OR JURISDICTIONS DO NOT ALLOW LIMITATIONS ON HOW LONG AN IMPLIED 
WARRANTY LASTS, THE ABOVE LIMITATION MAY NOT APPLY TO YOU. THIS WARRANTY GIVES 
YOU SPECIFIC LEGAL RIGHTS, AND YOU MAY ALSO HAVE OTHER RIGHTS WHICH VARY FROM 
JURISDICTION TO JURISDICTION. 
 
This disclaimer and exclusion shall apply even if the express warranty set forth above fails of its essential 
purpose. 
 
Disclaimer of Liabilities. IN NO EVENT WILL QUALITROL OR ITS SUPPLIERS BE LIABLE FOR ANY LOST 
REVENUE, PROFIT, OR DATA, OR FOR SPECIAL, INDIRECT, CONSEQUENTIAL, INCIDENTAL, OR 
PUNITIVE DAMAGES HOWEVER CAUSED AND REGARDLESS OF THE THEORY OF LIABILITY 
ARISING OUT OF THE USE OF OR INABILITY TO USE SOFTWARE EVEN IF QUALITROL OR ITS 
SUPPLIERS HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. 
 
In no event shall Qualitrol’s or its suppliers’ liability to Customer, whether in contract, tort (including 
negligence), or otherwise, exceed the price paid by Customer.  The foregoing limitations shall apply even if 
the above-stated warranty fails of its essential purpose. 
 
BECAUSE SOME STATES OR JURISDICTIONS DO NOT ALLOW LIMITATION OR EXCLUSION OF 
CONSEQUENTIAL OR INCIDENTAL DAMAGES, THE ABOVE LIMITATION MAY NOT APPLY TO YOU. 
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The Warranty and the Software License shall be governed by and construed in accordance with the laws of 
the State of New York, without reference to principles of conflict of laws, provided that for Customers located 
in a member state of the European Union, Norway or Switzerland, English law shall apply.  The United 
Nations Convention on the International Sale of Goods shall not apply. If any portion hereof is found to be 
void or unenforceable, the remaining provisions of the Warranty and the Software License shall remain in full 
force and effect. Except as expressly provided herein, the Software License constitutes the entire agreement 
between the parties with respect to the license of the Software and supersedes any conflicting or additional 
terms contained in the purchase order. 
 
If Customer has entered into a contract directly with Qualitrol for supply of the Products subject to this 
warranty, the terms of that contract shall supersede any terms of this Warranty or the Warranty Card, or the 
Software License, which are inconsistent with that contract.  Customer acknowledges that the Internet URL 
address and the web pages referred to in this document may be updated by Qualitrol from time to time and 
the version in effect at the date of delivery of the Products to the Customer shall apply. 

1.1 OmniFlex Family and Neoptix Probe Warranty Notice 
Your OmniFlex unit is guaranteed (Parts and Workmanship) for one full year from the date of purchase. 
Upon written notification of any defect, Neoptix will either repair or replace any faulty product or components 
thereof. A Return Authorization Number (RMA) must be obtained from Neoptix Canada LP or authorized 
distributor prior to any merchandise return. 
 
Due to the unique nature of the fiber optic probes that are used with the Neoptix Conditioner system, probes 
are not warranted. 
 
When using any electrical appliance, basic safety precautions should be followed, including the following: 

• Do not operate in wet / damp environments 
• Do not operate in explosive atmospheres 
• Keep product surface dry and clean. 

 
Always make sure all electrical installations are made in accordance with local authorities’ regulations and 
laws. 

Document no. G1005r04  Copyright Neoptix Canada LP 
 7 



2 INTRODUCTION 
Congratulations on the purchase of your OmniFlex-USB1 thermometer product! Your new temperature 
sensing system will soon allow you to take full advantage of the benefits inherent to fiber optic sensing 
technology. It offers accurate and reliable temperature measurements in a package that offers 
unprecedented configuration flexibility, combined with extraordinary insensitivity to EMI/RFI, high voltage 
insulation and disturbance free sensing due to the non-electrical nature of the sensor element used. 
 
Not only does the OmniFlex family of products gives consumers’ access to reliable measurements, but it also 
offers a simple user interface that makes the technology easy to use. Moreover, no special calibration is 
required when changing the fiber optic sensor elements. 
 
The thermometer chassis is packaged in a standard 4U 19” rack, which is ideally suited for industrial 
applications. It can also be used as a desktop instrument. 
 
The standard configuration is offered with an USB interface (b-type connector) as well as an analog output 
feature that can be used for remote interfacing purposes (picture below needs to be updated to show the 
USB connector). 
 

 
 

2.1 System description 
A complete OmniFlex system is normally composed of one or more OmniFlex chassis, and one or more 
signal conditioner modules (called OmniModules). Each chassis can accept up to 8 OmniModules. Neoptix 
offers different type of OmniModules, as follows (each must be purchased separately): 

o 2-channel, direct 
o 4-channel, direct 
o 4-channel, sequential 
o 8-channel, sequential. 

 
Internally, all modules, and chassis, are linked to each other via a high-speed RS485 link. For easy of 
connection to your PC computer, this internal signal is converted to a RS232 communication standard; baud 
rate is fixed at 38,400 (no parity, one stop bit, no handshake). When using the OmniLink software (one copy 
included with each chassis), the user does not need to worry about these interfacing details. 

1 The OmniFlex-USB product is referred as OmniFlex in this guide.  
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2.2 OmniFlex general specifications 
The following table gives specifications that are applicable to an OmniFlex system. Then, each OmniModule 
is described separately. 
 

Resolution 0.1°C 
Accuracy +/- 1°C 

Calibrated Temperature 
Range 

-35° to 175°C 

Usable Temperature 
Range 

-80° to 250°C 
Cryogenic temperature range available as an option* 

Number of channels* 1, 2, 4 or 8 (per module) 
Number of modules per 

chassis 
Up to 8 

Maximum number of 
channels 

512 

Probe length 1 to 300 meters 
Response time Typically 0.2 second per channel 

(probe configuration dependent) 
Unit User selection of °C or °F 

Operating temperature 0° to 50°C, non-condensing 
Storage temperature  -30° to 60°C 

Local display No local temperature display 
Each channel includes a probe working/non-working led 

Power 18 to 28VDC (24 VDC nominal) 
(see note below, front panel item #10) 

Size 19 inch rack mount (height: 4U) 
180H x 480W x 320D mm 

Weight 3 to 6 kg per chassis 
Standard interface USB (b-type connector) 

Analog output* (4-20mA or 0-10V) 
Sensor Dielectric epoxy or silicone tipped optical fiber 

 
*: Selection must be specified at time of order. 
 
WARNING: You must install the USB driver before you connect the OmniFlex chassis to your PC computer; 
please refer to Section 6.1 for specific instructions on how to do this. 

2.3 OmniModule specifications 

2.3.1 1-channel module (OFX-1D) 
Number of channels 1 
Electronic refresh time 0.1 second 
Size 175H x 50W x 250D mm 
Weight 1.1 kg 
Power* 18 to 30 VDC 

Current, typical: 0.12A @24VDC input voltage 
Current, worst case: 0.15A @24VDC input voltage 

 
*: Power consumption should be taken into account when cascading multiple chassis together. Take note 
that the standard Neoptix power module has a current capacity of 4A @24VDC. 
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2.3.2 2-channel module, direct (OFX-2D) 
Number of channels 2 
Electronic refresh time 0.1 second (direct) 
Size 175H x 50W x 250D mm 
Weight 1.4 kg 
Power (direct) 18 to 30 VDC 

Current, typical: 0.24A @24VDC input voltage 
Current, worst case: 0.30A @24VDC input voltage 

2.3.3 4-channel module, direct (OFX-4D) or sequential (OFX-4S) 
Number of channels 4 
Electronic refresh time 0.1 second (direct) 

1.0 second (sequential) 
Size 175H x 50W x 250D mm 
Weight 1.6 kg 
Power (direct) 18 to 30 VDC 

Current, typical: 0.5A @24VDC input voltage 
Current, worst case: 0.60A @24VDC input voltage 

Power (sequential) 18 to 30 VDC 
Current, typical: 0.12A @24VDC input voltage 
Current, worst case: 0.20A @24VDC input voltage 

2.3.4 8-channel module, sequential only (OFX-8S) 
 Number of channels 8 
Electronic refresh time 2.0 second (sequential) 
Size 175H x 50W x 250D mm 
Weight 1.2 kg 
Power 18 to 30 VDC 

Current, typical: 0.24A @24VDC input voltage 
Current, worst case: 0.33A @24VDC input voltage 

2.4 Options 
The following figure gives a description of the various probe configurations that are optionally available from 
Neoptix. 
 

General Purpose Probe T1: 

 
 

ST Coupling 
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ST-ST Extension Cable 

 
 
Other options and configurations are also possible; contact Neoptix for more information. 

2.5 Calibration 
Each OmniFlex OmniModule comes factory-calibrated. The OmniFlex system normally would not require any 
future calibration; however, an annual re-calibration is recommended every 12 months or whenever 
performance verification indicates that calibration is necessary, according to your ISO9000 requirement or 
equivalent. NIST traceable calibration certificates are available. All calibrations are performed at the factory. 
Contact your Neoptix Representative for further information. 
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3 UNPACKING 
Before using your OmniFlex thermometer, check the box content to be sure all items have been included. 
Your package should normally contain: 
 
• OmniFlex chassis 
• Signal conditioner module(s) 
• Blank panels (enough, so the total of modules and blank panels is 8 per chassis) 
• Power supply module (universal input: 100-240VAC, 50/60Hz) 
• Interconnection cable 
• Neoptix OmniLink™ software (supplied on a CD) 
• USB interface cable (A type male to B type male cable) 
• User manual (this manual), supplied on the same CD 
• Calibration Certificates, one for each signal conditioner. 
 
Options: 
• Fiber optic temperature sensor probes 
• Fiber optic extension cables (also called sometime “patch cords”) 
• Fiber optic coupling 
• Carrying case & accessories. 
 
Make sure all listed items have been received and are in good condition. Note any evidence of rough 
handling in transit; immediately report any damage to the shipping agent. Should a part be missing or 
damaged, please contact your distributor immediately. Returns must be made with the original packaging, 
accompanied by an authorization number (RMA). Your distributor will provide you with information concerning 
the return of merchandise. 
 
The carrier will not honor damage claims unless all shipping material is saved for inspection. After examining 
and removing contents, save packing material and carton in the event reshipment becomes necessary. 
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4 OMNIFLEX™ HARDWARE REFERENCE 
Warning: The USB interface requires that a special software driver be installed, before you attempt to 
connect your new OmniFlex system to your PC; refer to Section 6.1 for more information. 
 
Warning: When reconfiguring a system by removing or adding OmniModules, make sure power is turn off 
for all chassis composing your OmniFlex system (no green POWER LEDs should be lit, for all modules). 

4.1 Interface details 
The following figure shows the OmniFlex front panel, loaded with 8 OmniModules: 
 
 
 

 
 

 
 
 
 
The OmniFlex back panel is as follows: 
 
 

 
 
 
 

 3 

 1 

 8 

 5  2 

  7 

 4 

 6 
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The following presents a full description of the user interface as well as detailed instructions on how to use 
the thermometer. 
 

1) Sensor status light(s): There are a total of up to 8 lights for this, one for each channel. These indicators 
inform you about the system status, as applicable to each channel. If any remains off, this indicates that 
either that channel is disabled or there is a problem with that sensor (or with the optional extension cable 
connected to it). Check if all optical connectors are correctly mated or if the sensor fiber (or extension cable) 
is not broken. 

A quickly flashing light indicates that the calibration table applicable to this channel is corrupted. If this 
happens, the integrity of the temperature readings for this channel is not guaranteed; please use precaution. 
Contact Neoptix for further information on how to resolve this issue. 

2) USB communication interface: This port is used to interface to your PC, to configure and to extract 
information for the instrument. This USB b-type connector is similar to what you will find on a USB-printer. A 2 
meter USB cable is included with the unit. See below for a complete description of the serial commands that 
are available. 

When using an OmniFlex system that is composed of more than one chassis, make sure that ONLY ONE 
USB cable is used; any USB connector can be used, leave the other USB connectors unconnected. 

3) Power switch. Make sure the OmniFlex power supply module is connected and powered. With systems 
that have multiple chassis, you will need to turn on each chassis. When properly powered, each OmniModule 
should have its green POWER led on. 
 
4) Module status lights: 3 LEDs are provided on each module, as follows: 

• POWER led: Green, when this module is power up. 

• SERVICE led: Currently not used. 

• ACTIVITY led: Blinks red when this module sends information to your PC computer. 

5) Sensor connector(s): These are ST type connectors, mating to each of up to 8 optical temperature 
sensors.  If you need to extend a sensor fiber, you should use optional extension cables that are available 
from your Neoptix supplier. 

Warning: The fiber type that is used with your OmniFlex thermometer is of a special type, and it is 
recommended that you get ALL of your extension cables from Neoptix or a Neoptix authorized 
distributor. 

6) OmniModule address: Each OmniModule is uniquely labelled with an hexadecimal address number that 
can range from 0001 to FEFF. This address is used to inform the OmniLink software about the physical 
location of each module. See the Software section for more information. 

7) Analog output connectors: There are a total of 8 such connectors, one for each OmniModule. Prior to 
shipment, your OmniFlex thermometer was factory set to one of the following configurations: 4-20mA or 
0-10V output. The minimum analog output value corresponds to minus 100°C and the maximum analog 
output value corresponds to 300°C. The thermometer normal range is from minus 80°C to 250°C, so a 
minimum value indicates an under-range error; likewise, a maximum value indicates an over-range error 
condition. Note: OmniFlex OmniModules that have extended range, such as cryogenic versions, may differ; 
contact Neoptix for more information. If there is a sensor problem for a given channel, the analog output may 
take one of the following 3 states (refer to the “o” command, Section 6.3.3.2):  

a) It will toggle between the minimum and maximum values, at approximately 0.5 Hz; this indicates a 
sensor problem for that channel (o0). This is the default setting; to change it, you will need to use the 
RS-232 “o1” or “o2” command. 
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b) The analog output is forced to its maximum value (o1); this would indicate a “too-hot” situation. 
c) The analog output is forced to its minimum value (o2); this would indicate a “too-cold” situation. 

Warning: 1- Do not connect any external voltages to these outputs; this may cause permanent 
damage to the thermometer unit. 2- Avoid shorting output leads together, as this may destroy the 
electronic drivers inside the OFX modules. 

Note: If the OmniFlex unit is in “sleep” mode, the analog outputs will keep their values until the OmniFlex 
acquires new temperature values. 

8) 24 Volts DC power connector: You can use a DC power supply from 14V to 28V; note that at 15V or 
less, you will be unable to use more than one (1) 500Ω load at the analog output, for all current output 
configurations (4-20mA). Each OmniModule is fitted with an internal fuse, to protect the system in case of 
electrical problems; this fuse is not user changeable. 

See next Section for instructions on how best to connect power to your OmniFlex system. 

4.2 Connecting multiple chassis together 
The OmniFlex system has been designed to allow for flexible cascading of multiple chassis. The 
recommended technique to connect multiple chassis together is to use one power-supply module per 
OmniFlex chassis. 

4.2.1 One power-supply module per chassis 
This is the Neoptix recommended method, although it is a bit more cumbersome due to the fact that you 
need to use more power-supply modules. In this configuration (illustrated below), one power module is used 
for each chassis, using any one of the two power connectors found at the rear of each chassis (the use of the 
bottom connector, labelled “Power Input / In From Other OmniFlex” is recommended). 

The main advantage of this method is that you do not need to worry about the power rating of the power-
supply modules as each power-supply module has ample power capacity to drive a fully loaded OmniFlex 
chassis. 

Each power-supply module is wired with a communication dongle cable. If you are using only one chassis, 
this dongle cable should be left unconnected. If using multiple chassis, the dongle cable of the base chassis 
should be connected to any of the two power connectors found on the next chassis (“Out to OmniFlex” 
connector is recommended); the other connector should be used to connect the power-supply module to this 
chassis. 
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Use a proper USB cable to connect the OmniFlex system to your PC computer. Each OmniFlex chassis is 
fitted with a front USB B-type female connector; any front USB connectors can be used for this purpose. 
Warning: connect only one cable per system, any one is fine. 

4.3 Adding and removing OmniModule modules 
OmniModules can be added, removed or moved in a system. 

Warning: Make sure power is turned off before removing or adding any OmniModules. 

To remove a module: 

• Turn system power off. 

• Unscrew the 4 corner screws found at each corner of the module you want to remove. A small flat 
screwdriver is required for this. 

• Pull on the module firmly using the small handle located at the bottom of the module. 

• If no other module is to be inserted in the same location, make sure you use a blank panel to fill the hole. 
Screw the blank panel using the 4 corner screws. It is important to make sure no holes are present, to 
insure good system EMI rejection and integrity. 

• Configure the OmniLink software to “inform” it that you have removed a specific module. 

To add an OmniModule: 

• Remove the module or the blank panel located at the position where you want to insert your new module. 
Follow the instructions given above. 

• Insert the new module in the hole, and push it firmly until the module front panel is flush with the adjacent 
panels. Screw the module in place using the 4 corner screws. 

• Turn the power on, and confirm that the POWER led is lit. 

• Configure the OmniLink software to “inform” it that you have added a new module. 
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5 USING THE TEMPERATURE PROBES 

5.1 Caution 
Each time you connect a temperature probe to the unit, the probe optical connector should be cleaned 
beforehand. Otherwise, particles of grease or dirt may obstruct the device internal connector and affect the 
measurements by completely blocking the signal or by generating too much attenuation when using a long 
fiber length. 
 
Never use a cloth other than the type recommended for fiber optic cleaning. Dampening the cloth with pure 
isopropyl alcohol ensures good cleaning. 
 
Occasionally, clean the inside of the bulkhead connector (attached to the thermometer) with a wipe or cotton 
swab dipped in alcohol (2.5 mm mini foam swabs work best). 
 
Very dirty connectors could occasionally be cleaned using a strong solvent such as acetone (acetone is 
strong solvent, must be used with care). After using acetone, you should remove any deposits left by the 
acetone, using some isopropyl alcohol, as indicated above. 
 

Ferrule

Locking nut

Ferrule key

0 
 

5.2 Description 
The optical connector used is a standard ST type connector. 
 

Device connector
Insert the Ferrule key here 

Pins BNC type

To install the connector,  

Then, turning, insert the two BNC pins into
The appropriate slots on the ST connector.

Slide the ferrule key gently into the above key.
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5.3 Warning 
The T1 probe is quite fragile and it must be handled carefully. Please note that any probe damages are not 
covered by the standard warranty. 
 
The probe tip is made of silicone rubber. Although silicone is resistant to a large number of chemical 
aggressors, strong acids or alkali may damage it, especially at high temperature and/or if used for extended 
periods of time. Warning: Solvents and fuel oils can cause problems for silicone rubber. 
 
Neoptix also manufactures probes that have their tips made of epoxy. Just like silicone, epoxy resin is 
resistant to a large number of chemical aggressors, strong acids or alkali may damage it, especially at high 
temperature and/or if used for extended periods of time.  
 
Contact your distributor for additional chemical compatibility information. 
 
Do not expose your probes to temperatures that are higher than specified. Permanent damage can be 
caused to probes that have been exposed to temperatures that are higher than their limits. 

5.4 Working with long probes 
This note is important when using probes or extension cables that have a combined length of 100 meters or 
more. Working with long probes or extension cables presents special problems. To limit the amount of back 
reflection caused by the fiber optic connector located on the thermometer unit, you may have to use a 
matching gel optical couplant in the connector. This gel is a grease-like compound with high clarity, good 
resolution properties and a refractive index close to quartz. Apply the gel onto connector end faces. 
 
Avoid disconnecting the connectors for which gel has been used. In other words, it is recommended to use 
the gel only for permanent installations. If the connectors are disconnected many times, you may have to 
clean entirely the connector assemblies that have had the gel; this may require opening the instrument 
enclosure to remove the excess gel. 
 
Note that it is not required to use this gel with connectors that are far away from the thermometer electronic 
unit. 

5.5 Working with cryogenic probes 
The use of a cryogenic probe requires special attention. In particular, the probes become more brittle at very 
low temperatures. Avoid cycling the probes quickly between cryogenic temp and ambient temperatures, as 
this may cause material fatigue at the probe tips. 
 

Warning 
 

Always wear protective gloves and clothing when working with cryogenic material. 
 
Never use general purpose probes at cryogenic temperatures. Neoptix sells special probes that can be used 
at cryogenic temperatures. 
 
Please note that your OmniFlex thermometer will require a special factory calibration to be used at cryogenic 
temperatures (below –80oC). Consult Neoptix for more information. 
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6 OMNILINK SOFTWARE DESCRIPTION 
The Neoptix OmniLink™ software package option allows using your thermometer system in a highly flexible 
manner. The built-in functions allow for temperature displaying and data logging, as well as exporting to a 
variety of standard spreadsheet packages, such as Microsoft Excel. OmniLink has been developed based on 
the time-tested Neoptix-Assistant software package. 

6.1 Installing the USB software driver 
The USB driver has been developed by B&B Electronics, USA. The USB interface is in really a serial bridge 
that is interfaced to a USB port (it is serial port to USB converter). The B&B Electronics part number is 
USOPTL4, and the USB software driver is included on the CD that ships with this instrument; it can also be 
downloaded from Internet, at the following address: http://www.bb-elec.com/Products/USB-Connectivity/USB-
to-Serial-Adapters/In-line-USB-to-Serial-Converters/USOPTL4.aspx.  
 
IMPORTANT: You must install the software driver before you connect the OmniFlex to your computer. 
 
Futhermore, before using OmniLink, you will have to know which COM port number is being emulated by the 
USB converter; you can normally get this information from Windows “Device Manager” (normally available 
from “My Computer”). For example, the figure below shows that the COM port number is 5. 
 

 

6.2 Getting started with OmniLink 
OmniLink was designed to acquire temperature readings from all models of the OmniFlex thermometer 
family. This versatile software package is designed to work with Microsoft Windows operating system; to fully 
exploit the capabilities of OmniLink, it is recommended to use it in conjunction to commercial spreadsheet 
software, such as Microsoft Excel. 

6.2.1 Hardware and software requirements 
The following list includes the minimum requirements for running the Neoptix-OmniLink software: 
 

o A Pentium class or higher CPU 
o VGA or higher resolution display system supported by Windows 
o 256 MB of RAM memory (4 GB with Win7) 
o At least 25 MB of hard disk space 
o A CD disk drive (to load software) 
o A mouse or other Windows pointing device 
o A RS-232 interface (COM1 to COM32) 
o Windows XP or later (Win7 and XP preferred) 
o A Windows supported printer. 

6.2.2 Installing OmniLink 
Before opening the CD and installing the software, please refer to the License and Limited Warranty 
Agreement at the beginning of this manual. 
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You must have at least one, or more, properly installed OmniFlex thermometer unit(s). 
 

1- Start Windows, and make sure you are not running any other Windows program. 
2- By inserting the CD in your computer, the SETUP application should automatically start; if not, start it 

manually. 
3- Follow the instructions that are displayed. 
4- Restart your computer. 

6.3 A quick tour of OmniLink 
1- Connect your OmniFlex unit(s) to the COM port; see Section 4.2 for specific instructions on how to 

do this. 
2- Start OmniLink, if not already running. 

 

3- The following Main Window is displayed: 
 

 
 
This Window is the first window you will see after starting OmniLink. This is the most complex window in this 
software package; however, it is important to set it up correctly to ensure an easy and reliable operation of 
OmniLink. 
 
As shown in the figure below, the window is logically arranged in 2 sections as follows: 
 

• The top portion has to do with the hardware configuration of your computer and thermometer units. It 
is also used to set up configuration and data file names. 

 
• The bottom section is used to display and log system messages, as you make changes to your 

configuration and other system operations. 
 
Click the “Init System” button to establish communication between the OmniFlex system and the OmniLink 
software and confirm that the physical link between your PC and the OmniFlex is correct. For example, if you 
read the last line of information in the figure below, you will notice that zero modules have been detected; this 
indicates that OmniLink has not been able to communicate with your OmniFlex hardware. This situation may 
be caused by: 
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1- Modules have not been edited yet, or that the information given in the edit window is erroneous. 
2- Your physical link between your PC and the OmniFlex chassis is broken. 

 

 
 
On another hand, if by clicking on the “Init System” button, and you get the following, this confirms that 
OmniLink has been able to communicate with one or more OmniModules (as shown below, two modules 
have been detected in positions # 1 and # 2 of chassis # 1). 
 

 

Document no. G1005r04  Copyright Neoptix Canada LP 
 21 



 
As can be read from the above screen shot, the last line indicates “0 Errors”, which means that the 
automatically detected hardware configuration is in accordance with the OmniLink saved configuration. If you 
get 1 or more errors, you will need to configure OmniLink, as explained in the next Section, to make sure that 
your “hardware” configuration corresponds to your “software” configuration. 
 
Hint: When OmniLink is first started, it is possible that some undesirable characters are still present in the 
PC serial communication protocol; to avoid any problems link to this, it is suggested to click twice on the “Init 
System” button to assure that no error is due to this. 
 
The next Section explains how to configure your modules so OmniLink can detect them correctly. 

6.3.1 Configuring the OmniModules 
From the Edit menu, select “Edit OmniModules”. The following window will open: 
 

 
 
The chassis illustrated above has two OmniModules installed. 
 
The most important parameter here is the Module Address. This address allows OmniLink to recognize this 
particular module (OmniModule). Each OmniModule has a unique address (expressed as a hexadecimal 
number), somewhat similar to a MAC address for an Ethernet controller. To help you, Neoptix prints this 
address directly on the module, just above the little handle present on each module. Simply enter the printed 
address in the “Module Address:” text-box in the System Layout window, so the module shows up in the 
same physical location as it appears in the window; doing this matching helps the user in mapping correctly 
any OmniModule location. 
 
• To disable an OmniModule, simply make sure that the “Module Address:” text-box is empty. 
 
• You can enter a name of your choice for each channel, in the “Name” text-box. 
 
• To enable or disable logging for any channel, check or uncheck the corresponding “Log” checkbox. 
 
Up to 8 chassis are supported by this layout window. When working with multiple chassis, you can select the 
chassis you want to configure by clicking on the appropriate “Chassis x” buttons, found in the upper portion of 
the Configuration window. 
 
When done configuring OmniModules, click “Close” to close this window. You will be given the opportunity to 
save, or discard your changes. 
 
You are now ready to display temperatures, and optionally log them. 
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6.3.2 Displaying temperatures 
The simplest method that you can use to display temperatures is to open the “Temperatures” window. First, 
click the “Start Acquisition” button; then, from the task bar, select Window, and then View Temperatures2. 
The following window will appear: 
 

 
 
The displayed temperatures are updated according to the “Acq. interval (sec)” setting (in the main window). 
 
999.66 is displayed for channels that cannot be read (no probes or broken probes). 

6.3.2.1 Viewing the Temperature Trends window 
The next method that you can use to visualize your temperature values is to use the Trends window. As with 
the Temperatures window, this window may be automatically displayed if the “Launch Trends automatically” 
is selected (from the Edit task bar menu item). 
 
From the main task bar, select “Window” and the “View Trends”. The following window will appear: 
 

2 This window will appear automatically if the “Launch temps. window automatically” option is selected (from 
the Edit task bar menu item). 
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To change which traces will be shown in this window, click Edit and click one or more times the trace name 
to enable or disable this trace (the presence of the check mark indicates that this trace will display). Once 
done editing, click the same button to return to the display mode (each time the trend configuration is edited, 
all traces are cleared). 

6.3.2.2 Logging temperatures 
OmniLink offers the possibility to log temperature values to an Excel compatible file. The file name must be 
selected from OmniLink main window, and the “Log data to file” checkbox must be checked. The default file 
extension is .tem; this file can be subsequently opened using Excel, which should open it and automatically 
recognize as an Excel compatible CSV file. Default file location is “My Documents”, for Windows 7 and 
above. 
 
When subsequently trying to open the *.tem file, it is possible that you may get the following message: 
 

 
 
Select “Select the program from a list”, and click OK. In the next window, you should instruct Windows to 
always open this type of file with Microsoft Excel. 
 
If you get the following message, you should select “Read Only”. 
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In Excel, the data file should look like this: 
 

 
 
Notes: 1) The C column is a date/time stamp, which gives the number of seconds since the first of 

January 1970. This is a standard time stamp used by industrial controllers. 
 2) If a column shows “#######”, this means that this column is too narrow to display the data; 

use your mouse to widen this column. 
 3) If you open a logging file during acquisition, the Excel window is not refreshed as the 

acquisition is taking place. To get a more recent version of the file, close the Excel program, and 
start Excel again. 

 
If you stop the acquisition, and start it again with the same file name, the new values will simply be appended 
to the existing file content. However, a new 4-line header is inserted first, as shown here: 
 

 
 
When logging temperatures for a very long time, one needs to note that a standard Excel sheet is limited to 
65535 lines. If this limit is reached, the logging process will close the current data-logging file, and will open a 
new one, with the same name but with “_1” appended to the file name, and so on (“_2” …), until the 
application is stopped or your disk becomes full. 
 
For more detailed information on each menu item, please refer to Section 6.4 below. 
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6.3.3 The OmniLink console 
The console, which can be invoked through the Window and then Open Console from OmniLink main 
window menu bar, is useful to manage each OmniModule in details. Take note that the console can only be 
opened when no temperature acquisition is taking place. It can be useful also to understand problems and 
malfunctions that a module may exhibit. It operates in a similar fashion as Windows HyperTerminal, which 
Neoptix suggests to use with other of its thermometer models (such as the Reflex or T/Guard). 
 
The console can be used to get information such as: 
 
• Information on calibration date, serial number, etc. 
 
• Enable / disable channels 
 
• Set the analog output parameters (zero and span) 
 
• Control operational features, such as fast/slow scanning more, wtune, etc. 
 
The following illustrates the OmniLink Console: 
 

 
 
Before sending commands and receiving information from a specific module, it is necessary to enter the 
OmniModule address of the module that you want to interrogate. Please note that only ONE module can be 
selected at a time; if the same command is to be sent to all modules, then it is necessary to repeat the 
command for each individual module (unless the broadcast command is used, see below). 
 
Make sure the cursor is at the bottom of the screen before sending a command. 
 
You can use “Copy and Paste” Windows commands (such as the following shortcuts: ctl-c and ctl-v) to copy 
selected content of the console content to other Windows programs, such as Notepad, etc. 

6.3.3.1 Console help menu 
The following is the menu as displayed by the instrument when sending the “h” command. This help menu 
can be used as a reminder of all available commands. 
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OmniModule-1 OmniModule-2 to -8 Description 

a a Ignore 
b b Return enclosure temperature 
N/A e[1;2; ... ;n] Enable channels to scan (if no argument, scan all) 
f[j] f[i;j] Set point adjustment on channel [i] to [j] 
gskip[i] gskip[i] Skip up to i marginal read cycles 
h h Help menu (this screen) 
i i Get factory and status information 
l[i] l[i] Lock the keypad (l+ to lock, l- to unlock) 
n+o or n+e n+o or n+e Toggle calibration ( n+e for Neoptix, n+o for Nortech Fibronic inc.) 
o[i] o[i] Analog out, if error (0:Max-Min 1Hz, 1:Max level, 2: Min level) 
p[i] p[i] Sleep mode (p+ to sleep, p- for continuous scanning) 
q q Scanning rate (q+ for fast/quick, q- for slow) 
r r Ignore 
s[j] s[i;j] Specify analog output Span [j] for channel [i] 
t t[i] Get Temperature reading channel [i] 
ta[i] ta[i] Auto temperature output to serial port (+ to enable, - to disable) 
tb[nnnn] tb[nnnn] Ignore 
u[i] u[i] Unit (c = oCelcius, f = oFahrenheit) 
x x Ignore 
wtune[i] wtune[i] Optimize CCD read time (wtune+ to enable, wtune- to disable) 
y y Quality index 
z[j] z[i;j] Temperature [j] for analog output Zero on channel [i]. 

 
As an example, this table can be invoked by typing the “h” command, as follows: 
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6.3.3.2 Detailed description of RS-232 commands 
All commands must be terminated by a carriage return character ( E  ). When more than one argument 
are required, each argument must be separated from the next one by a blank or space character. Characters 
are not echoed back to your controlling device. 
 
Every time a command is executed successfully by the thermometer, the “*” prompt character is 
automatically sent, except in case of failures when the “Errx” error code is sent instead. Do not send your 
next command before receiving either the “*” or the “Errx” prompt. The “[“ and “]” characters must not be 
typed in; they are used here for ease of reading only. 
 
Most commands are applicable to all OmniModule versions (different number of channels). When using one-
channel model, the channel number [i] must not be typed in. 
 
“a” Ignore. 
 
“b” This command returns the internal temperature of the enclosure. The temperature is returned in oC or oF 
unit, as specified by the “u” command. 
ex: “b:32.2 E “ 
 
“c” or “c[i]” Ignore. 
 
“e[[-]1  [-]2  ...  [-]n]” This command is not recognized by the one-channel model. Specify which channels 
are enabled and read by the addressed OmniModule. Preceding a channel number with the minus sign “-” 
will disable that particular channel. This command is useful to ignore channels that are not currently used. 
Enter the channel numbers that you would like to use, each one separated by a blank character. 
ex: “e-1 2 3 E “, to enable only channels 2 and 3 and at the same time to deactivate channel 1. 
 

Document no. G1005r04  Copyright Neoptix Canada LP 
 28 



“f[j]” or “f[i  j]” This command forces an actual temperature reading (j) for channel # i; any resulting offset 
will be applied to all future measurements for that channel. This is useful to compensate for small 
temperature deviations that may occur between sensors. A maximum offset of +/-5oC is recommended; if it is 
required for you to force a larger offset, your thermometer probably requires a new factory calibration; consult 
your distributor or factory for more information. This command can also be used to force older Nortech 
Fibronic inc. probes to read similar temperatures as the newer Neoptix probes. This command alters the 
internal calibration of the instrument. Always follow the recommended procedure, as given below. 
 
Force temperature procedure: 
 

I. Apply a stable and known temperature to the sensor tip 
II. Check the display reading for abnormal deviation from the known temperature 
III. Send the “f” command followed by channel number, a blank character and the reference 

temperature value (example “f2 27.0 E “). Temperatures must be entered in units as 
specified by the “u” command 

IV. Wait a few seconds 
V. Confirm that the readings correspond to the known temperature. 

 
Note: You can revert at any time to the factory calibration using the “f” (or “f[i]”) command (ex: “f2 E ”). 
 
Note: Always make sure you are reading a valid temperature value before using the “f “ command; otherwise, 
your thermometer may display a random value for a channel where the “f” command has been used. 
 
“gskip[i]” This command is useful to eliminate annoying dropouts that can happen when using “weak” 
probes. The parameter “i” indicates the number of scans that the system will perform before actually 
indicating that it cannot read the probe on a specific channel. The range of i is from 0 to 9; a value of 0 
indicates that the OmniModule makes no attempt at removing dropouts. A value of 3 to 5 is recommended, 
especially for transformer applications. This command is active even when the sleep command is valid, but is 
limited to a timeout of 2 minutes. 
 
“h” Displays a help menu screen (see above). 
 
“i” Returns general information regarding the instrument, as well as some parameters that have been 
programmed previously in the thermometer: 

Ex: Model: OmniFlex Direct 
 Option: NB Channel:4 
 Mode: Continuous Scanning Mode 
 Serial: RFX32A 
 Internal Software: V1.21 
 Last Factory Calibration*: 05/02/04 (YY/MM/DD) 
 Unit oC 
 Analog out, if error Toggle Max-Min 1Hz 
Channel Zero Span Enabled  Offset* Firm. rev. 
1 xxx.x xxx.x Yes/No  ±xxxx.x 23 
2** xxx.x xxx.x Yes/No  ±xxxx.x 23 
3** xxx.x xxx.x Yes/No  ±xxxx.x 23 
4** xxx.x xxx.x Yes/No  ±xxxx.x 33 

       
*: Temperature differential that is a consequence of the “f” command. 
**: Only for multi-channel models. 
 
“l[i]” Not applicable to the OmniFlex. This command is useful to prevent a local user from configuring the 
thermometer using the keypad. “i” can take two values: “+” or “-“; entering “l+” will lock the keypad, while “l-“ 
will unlock it, thus enabling a user to make local changes. A locked keypad can only be unlocked using the “l-
“ RS-232 command. 
 

Document no. G1005r04  Copyright Neoptix Canada LP 
 29 



“n+o” or “n+e” This command can be used to change the calibration type that is active at any give time. 
“n+o” should be used to enable the Nortech Fibronic inc. calibration, while “n+e” should be used for Neoptix 
probes. 
 
“o[i]” This command can be used to change the behavior of the analog output(s) when the OmniFlex 
thermometer cannot read a temperature for this channel. “i” can take one of three values: 
a) i=0. This is the default value, to assure compatibility with older Nortech Fibronic inc. thermometers. 

With this setting, the analog output will oscillate between its maximum and its minimum value at a 
rate of approximately 1Hz. 

b) i=1. In case of a probe problem, the analog output for this channel will be forced to its maximum 
possible value (e.g., 10V or 20mA). 

c) i=2. In case of a probe problem, the analog output will be forced to its minimum possible value (e.g., 
0V or 4mA). 

 
“p[i]” This command allows the user to force the OmniFlex thermometer to enter in sleep mode (p+) or to 
exit it (p-). Once in sleep mode, the thermometer will acquire new temperature values ONLY when the “t” or 
“t[i]” command is received; when the t command is received, the thermometer will immediately scan all 
enabled channels, and the new temperature values will be sent through the serial link, after which it will return 
again in sleep mode (there is no need to resend the p+ command again). 
a) When the thermometer is powered on, the sleep mode is always disabled. 
b) When new temperature values are acquired, these new values will be shown on the display (if 

present) for about 40 seconds, after which “Sleep mode” will be displayed. 
c) The analog outputs will keep the last temperature readings, until new ones become available. 
d) The front panel led status lights will keep their values until new readings are acquired. 
 
“q” “q” allows for selecting the fast (q+) or the slow (q-) acquisition mode. In slow mode, the last 4 
temperatures are averaged before being displayed or sent to the serial port; this provides a better reading at 
the expense of being slower. 
 
“r” Ignore. 
 
“s[j]” or “s[i  j]” This command will set the analog output span for the analog channel # i (if using a multi-
channel thermometer, the “i” parameter specifies the channel to which the command is addressed). The “j” 
parameter specifies the span that can range from 1.0 to 1000.0, in temperature units that are defined by the 
last “u” command. 
 
“t” or “t[i]” Returns the current temperature reading for channel # i. “---.-” is displayed if the specified 
channel number is not currently enabled or when no valid temperature is available for the requested channel. 
However, during the initial warm-up time, the error “Err1” is sent in response to the “t” command. For multi-
channel instruments, if the “t” command is received without parameter, the temperatures for all channels are 
returned. All temperatures are returned in oC or oF unit, as specified by the “u” command. 
ex: “t4 E “ will return the temperature for channel # 4. 
 “t E ”, with the OmniFlex-4 thermometer, will return: 
  +24.3<CR> 
  +24.5<CR> 
  +24.7<CR> 
  +24.4<CR> 
  * 
 
The “t” command is also available in a special “ta” version, that can be useful for continuously and 
automatically monitoring all enabled channels. This special mode is recommended when automatically 
acquiring temperature readings with suitable data-logging software, and can be activated by issuing the “ta+” 
command, or deactivated with the “ta-“ command. Once activated, the following information is automatically 
sent when the temperature on a channel has been acquired: 
 “C:I;T: ±xxx.x<CR>” 
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where i is the channel number, and xxx.x is the temperature reading (signed number). For the OmniFlex-1 
model, i is always 1. 
 
“tb[nnnn]” Ignore. 
 
“u[i]” Set units of measurements to either Celsius (i=c) or Fahrenheit (i=f). Note that this unit selection is the 
same as the temperature unit selection made from the keypad (if the display option is installed). 
ex: “uc E “, to select ºC (Celsius). 
 
“x” Reserved for service and maintenance purposes. 
 
“wtune[i]” This command can be used to increase the optical integration time of each channel (each of the 
1 to 8 channels are treated independently) to force an OmniModule to read temperatures when the optical 
signal is weak, at the expense of a slower response (slower temperature update frequency). This command 
(wtune+) enables this feature for all channels (individual channel cannot be enabled or disabled). It should be 
noted that in general the scanning rate of the system would slow down when this command is enabled. It is 
highly recommended for power transformer applications. 
Warning: When wtune is enabled, and that a probe is inserted, or removed, it may take some time (from 
several seconds to as much as a minute, when multiple channels are being optimized at the same time) for 
the OmniModule to detect the probe, due to the optimization process that takes place. 
 
“y” The “y” command can be used to confirm the “quality” of a probe and/or its connection. It can be used as 
a diagnostic tool to confirm the good operation of a probe and its extension cable (if applicable) connected to 
a channel. The returned value can be between 1.00 to approximately 3.00; a higher value is better. A 
minimum of 1.25 is required for a channel to return a temperature. 
ex: “t E ”, with an OmniModule-4 thermometer, will return: 
  CH1:2.61, lamp attenuation: 250, CCD time: 250ms (auto*)<CR> 
  CH2:2.51, lamp attenuation: 250, CCD time: 100ms (auto)<CR> 
  CH3:2.38, lamp attenuation: 125, CCD time: 500ms (auto)<CR> 
  CH4:1.09**, lamp attenuation: 125, CCD time: 500ms (auto)<CR> 
 
*: Value: Auto (when wtune+ is active) or Fixed (when the wtune command is disabled). 
**: 1.0 to 1.1 indicates that no probe is detected for this channel. 
 
“z[j[“ or “z[i;j]” This command is used in conjunction with the “s” command, as it sets the temperature that 
corresponds to the analog zero (minimum value of analog output). For multi-channel models, the “i” 
parameter specifies the channel to which the command is addressed; valid values are 1 to 8 (the maximum 
value depends on the number of channels of each OmniModule). The “j” parameter specifies the zero 
temperature value, and can range from -100.0 to 1000.0, in units that are defined by the last “u” command. 
Factory default is -100.0; OmniFlex thermometers that have been factory calibrated for cryogenic 
temperatures have a lower setting. 

6.3.3.3 Error codes 
The following error messages are displayed under certain error conditions: 
 

RS-232 Display Analog Out Description 
Err2 Err2  Internal memory checksum error. Memory corruption. 

When a channel has its calibration table corrupted, the 
corresponding front panel LED will continuously flash to 
indicate the corruption problem. Contact Neoptix. 

“- - . -” “- - - - -” Hi-Lo, 0.5 Hz* Temperature out of maximum instrument limits or no signal 
Err5   Argument out of range 
Err6   Unrecognized command 

 
*: The exact analog output behavior is a function of the command “o”; see previous Chapter. 
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Note that these error codes are not applicable when using the OmniLink software package. This high-level 
software package is programmed to automatically handle all types of errors. 

6.3.3.4 The Broadcast Command 
To simplify sending the same command to multiple OmniModules, a special broadcast command feature is 
included in OmniLink. Click the “Broadcast Cmd” button, or select “Broadcast Command” from the File menu 
bar); the following window is displayed: 
 

 
 
As can be seen from this window, the Broadcast Command feature offers a simple yet elegant way to send 
common parameters to all OmniModules. It is also useful to assure that ALL OmniModules are programmed 
with similar parameters, thus avoiding potentially disastrous errors. 
 
To change a class of parameters, as illustrated in the above figure, simply select the correct value for a given 
parameter, and click the corresponding Update button. Please note that if you have many OmniModules in 
your systems, the update process can take many seconds. 

6.4 OmniLink functions 
This section explains in detail each one of the functions provided by the menus of the OmniLink software 
package. 

6.4.1 The File menu 

6.4.1.1 Quit 
Select Quit from the File menu to exit OmniLink and return to your Windows operating environment. If you 
have made changes to any file, be sure to save all files to disk before quitting. 
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6.4.2 The Edit menu 

6.4.2.1 Edit Configuration 
Select this menu item to configure your OmniModules. For a new installation, this is one of the first menu 
items you need to choose in order to properly configure your OmniFlex system. Amongst other things, you 
can set the following parameters: 
• OmniModule address (usually a 3-digit hexadecimal number) 
• Channel names (your reference names) 
• Logging enable / disable status. 
 
You should set the addresses so the OmniModules appear in the same order (within a chassis and amongst 
multiple chassis) as your physical module layouts; doing so should simplify the “visualization” of your 
OmniFlex system. 

6.4.2.2 Edit Trends 
This selection allows for setting the look of the trend graphic window. It is equivalent to clicking the Edit button 
that shows in the Trends window during temperature acquisition. 

6.4.2.3 Launch Trends window automatically 
Click this menu item to toggle between having the Trends window automatically displayed or not, when the 
“Start Acquisition” button is pressed. 

6.4.2.4 Launch Temp. window automatically 
Click this menu item to toggle between having the Temperatures window automatically displayed or not, 
when the “Start Acquisition” button is pressed. 

6.4.3 The Window menu 

6.4.3.1 Open Console 
The console allows for accessing all setup and control parameters that are available from each OmniModule. 
It imitates the Windows HyperTerminal program, which Neoptix recommends to use with other Neoptix 
products. 
 
Take note that the Console can be invoked only when no temperature acquisition is taking place. 

6.4.3.2 View Temperatures 
This command calls the Temperatures window, as explained above. Please note that this view can be 
displayed automatically by toggling correctly the “Launch Temp. window automatically” in Edit menu. 

6.4.3.3 View Trends 
This command calls the Trends window, as explained above. Please note that this view can be displayed 
automatically by toggling correctly the “Launch Trends window automatically” in Edit menu. 

6.4.4 The Help menu 

6.4.4.1 Help 
This is a standard Windows Help menu. 

6.4.4.2 About 
For information and support only. 
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